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Preface

Description

Safety

The Greenlee Communications fiberTOOLS™ 930XC instruments are handheld Optical Time
Domain Reflectometers (OTDRs) for measuring the specifications of single-mode or multi-mode
optical fiber.

e The 930XC-20C measures optical fiber at 1310 nm and 1550 nm.
e The 930XC-20M measures optical fiber at 850 nm and 1300 nm.
e The 930X C-30F measures optical fiber at 1310 nm, 1550 nm, and 1625 nm.
e The 930XC-30P measures optical fiber at 1310 nm, 1490 nm, and 1550 nm.

Included with the 930XC instruments are the following:
e USB and serial data transfer cables
e Power adapter
e Vehicle adapter power cord
e Trace Viewer software installation disk
e Instruction manual

e Soft carrying case

Safety is essential in the use and maintenance of Greenlee tools and equipment. This instruction
manual and any markings on the tool provide information for avoiding hazards and unsafe
practices related to the use of this tool. Observe all of the safety information provided.

Purpose of This Manual

Warranty

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual

This instruction manual is intended to familiarize all personnel with the safe operation and
maintenance procedures for the Greenlee Communications 930XC handheld OTDRs.

Keep this manual available to all personnel. Replacement manuals are available upon request at no
charge.

Greenlee Textron Inc. warrants to the original purchaser of these goods for use that these products
will be free from defects in workmanship and material for one year. This warranty is subject to
the same terms and conditions contained in Greenlee Textron Inc.’s standard one-year limited
warranty.

For all Test Instrument repairs, contact Customer Service at 800-642-2155 or 760-598-8900 and
request a Return Authorization.

For items not covered under warranty (such as items dropped, abused, etc.), a repair cost quote is
available upon request.

Note: Prior to returning any test instrument, please check replaceable batteries or make sure the
battery is at full charge.

All specifications are nominal and may change as design improvements occur.
Greenlee Textron Inc. shall not be liable for damages resulting from misapplication or misuse of its products.

fiberTOOLS is a trademark of Textron Innovations Inc.



Important Safety Information

SAFETY ALERT SYMBOL

This symbol is used to call your attention to hazards or unsafe practices which could result

in an injury or property damage. The signal word, defined below, indicates the severity of the
hazard. The message after the signal word provides information for preventing or avoiding the
hazard.

ADANGER

Immediate hazards which, if not avoided, WILL result in severe injury or death.

AWARNING

Hazards which, if not avoided, COULD result in severe injury or death.

ACAUTION

Hazards or unsafe practices which, if not avoided, MAY result in injury or property damage.

AWARNING

Read and understand this material before operating or servicing this
equipment. Failure to understand how to safely operate this tool could result
in an accident causing serious injury or death.

AWARNING

Electric shock hazard:

Contact with live circuits could result in severe injury or death.

C E Class 3 appliance

6 Greenlee / A Textron Company



Important Safety Information

AWARNING

Electric shock hazard:

o Do not operate in an explosive atmosphere such as in the presence of flammable gases or
fumes.

o Before applying power, verify that the unit is set to match the available line voltage.

Failure to observe this warning could result in severe injury or death.

AWARNING

Electric shock hazard:
o Fuse replacement should be performed by Greenlee qualified personnel.

o Do not use repaired fuses or short-circuited fuse holders.

Failure to observe these warnings could result in severe injury or death.

The 930XC instruments are laser devices

conforming to the requirements of CDRH,
C AU TI O N CFR 1040, Subchapter J. While there is no

potential for eye damage due to unaided
direct exposure, users should always avoid
LASER LIGHT looking directly into the output port. The
DO NOT STARE INTO BEAM | use of optical viewing instruments, such
as microscopes, magnifiers, etc., should
always be avoided. The use of such devices
around active fibers can focus an intense
beam of light energy onto the retina of
the eye, which can result in permanent
damage.

CLASS | LASER PRODUCT

ACAUTION

Laser hazard:

o When performing measurements on fiber optic systems, avoid eye exposure to any open-
ended fibers, optical connectors, optical interfaces, or other sources because they may be
connected to active laser transmitters.

« Do not look into the optical port when a source is turned on.

» Avoid looking at the free end of a test fiber, i.e., the end not connected to the instrument.
If possible, direct the free end toward a non-reflective surface.

Failure to observe these precautions may result in injury.

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual 7



Important Safety Information

ACAUTION

Electric shock hazard:

+ Do not expose batteries to fire or intense heat. Do not open or mutilate batteries. Avoid
touching the electrolyte in the batteries, which is corrosive and may cause damage to eyes or
skin.

« Do not open the case of the unit for any reason. It contains no user-serviceable parts.

o Use this unit for the manufacturer’s intended purpose only, as described in this manual. Any
other use can impair the protection provided by the unit.

Failure to observe these precautions may result in injury and may damage the unit.

ACAUTION

Instrument damage hazard:

o Make sure that the optical fiber or cable is not in use and there is no laser beam in the fiber
before testing with this unit.

+ Do not leave the unit in direct sunlight or near direct sources of heat.
o Protect the unit from strong impacts or shock.
« Do not immerse the unit in water or store in areas with high humidity.

o When necessary, clean the case, front panel, and rubber cover with a damp cloth. Do not use
abrasives, harsh chemicals, or solvents.

o Replace the protective dust cap when the unit is not in use.
o Store the unit and interface adapters in a cool, dry, and clean place.

Failure to observe these precautions may result in injury and may damage the unit.

ACAUTION

Electric shock hazard:

+ Do not expose the unit to extremes in temperature or high humidity. Refer to
“Specifications.”

o Turn the unit off, disconnect from power, and make sure the laser source is off before
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.

8 Greenlee / A Textron Company



Section 1. Introduction

Greenlee’s 930X C handheld OTDRs can make an assessment of one single optical fiber or a whole
optical fiber chain. In addition, the user can directly observe loss and events distribution of an
optical fiber chain.

The 930XC tools check the transmission quality of optical fiber through the measurement of
backscatter. Standard organizations like the International Telecom Union (ITU) define backscatter
as an effective analysis means to measure optical fiber loss. Backscattering is also the only
effective way of connector inspection, which can be applied to measure the length of optical fiber.

The 930XC OTDRs operate by reviewing events in optical fiber (for example, irregularities and
connectors). These tools can help identify irregularities in optical fiber, locate them, and measure
their attenuation, relevant loss, and homogeneity.

These tools are easy-to-use, small, and compact with large LCD displays and graphical interfaces.
They can save and transfer the measurement curves data to a PC by using the provided Trace
Viewer software for further analyzing, reporting, and printing.
Basic applications:

e Measure the length of optical fiber and cable.

* Measure the distance between two points on optical fiber and cable.

e Locate faults and ruptures of optical fiber and cable.

» Display distribution curve of optical fiber and cable loss.

e Measure attenuation coefficient of optical fiber and cable.

e Measure loss between two points on optical fiber and cable.

e Measure loss of tie-ins.

* Measure reflection of reflection events of optical fiber and cable.

e The 930XC-30F can measure live optical fibers at 1625 nm.
For a specific event (transmission quality changed due to faults caused by fusion splicing,
connector, bending, etc.), the following measurements can be carried out:

e For each event: Distance, loss, and reflection.

* For each section of optical fiber: Length and loss of dB or dB/unit length.

* For the whole optical fiber chain: Length and loss of dB.

Additional features:
e Large LCD display with auto or manual adjustment of contrast.
* Backlight LCD display supports night operation.
» Easy operation with trace graphic display.
e Trace storage function.
e RS-232 and USB data upload ports.
e Trace Viewer software for analyzing and reporting previously stored data.
e Auto off function to conserve battery life.

e DC/AC power supply.

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual 9
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Section 2. Basic Operation

This section describes the basic operation of the 930XC instruments. Specific operations are
explained in detail in Section 3 of this manual.

Instrument Interface Description

Figure 2-1. Interface Panel

Charge Indicator: When lit, measurement power is charging.
Power Indicator: When lit, measurement power is on.

AC Power Jack: Power adapter jack requirements are 13.8 VDC at 1.2 A.

Lol A

Data Transfer Ports: USB and RS-232 interfaces to transfer saved traces in the instrument to
a PC for further analysis with Trace Viewer software (provided).

5. Fiber Optic Output for OTDR or 1625 nm live fiber, and VFL (visual fault locator):
Connector is used for the OTDR interface.

6. Invisible Laser Caution: Do not look directly at the optical output or stare at the laser beam.

7. OPM Optical Power Meter

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual 11



Section 2

Use of Batteries

The 930XC tools use a NiMH battery.

Auto Off Mode

e The instrument will enter auto off mode when there is insufficient power during operation.
The low power icon will be displayed on the LCD.

e If unused for a long time, causing insufficient power, the instrument will enter auto off
mode several seconds after powering on in order to protect the batteries in case of excessive
discharging. The internal battery should be recharged immediately through the adapter.

Recharging

* Perform a quick charge first, and then switch to trickle charge after the voltage reaches a
predefined figure. Quick charge temperature is 5 °C to 45 °C (41 °F to 113 °F), and trickle
charge temperature is 0 °F to 55 °C (32 °F to 131 °F). Battery will not be fully charged or may
be damaged if the charging temperature is beyond the above range, which may shorten battery
life.

* A quick charge takes 3 hours.

12 Greenlee / A Textron Company



Basic Operation

Keypad Functions

930XC fiberTOOLS™

N
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1 »| on/off

Run/Stop|
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% @GREENLEE,, )
COMMUNICATIONS

Figure 2-2. 930XC Keypad

D ;:bD
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1. On/Off: Press to turn power on or off to the instrument.

2. Run/Stop:
e Under GUI, press to start measurement.

e While testing, press to stop measurement.

3. Enter:
e Under GUI, press to confirm the current operation.

* Use with the Shift key to zoom out trace vertically.

4. AV (up and down) arrows:
* Move menu bar in menu operation.
* Highlight the icon to be selected.
* Adjust parameter in parameter configuration.
e Use ¥ with the Shift key to browse up the events list.
* Use A with the Shift key to zoom in trace vertically.

5. <« P (left and right) arrows:
e Select parameter to be adjusted in parameter configuration.
*  Move marker left or right in trace operation.
e Turn page while in Help submenu.

* Use with the Shift key to zoom out or zoom in trace horizontally.

6. K arrow:
e Read Help menu when power on.
e Cancel the current operation.
e Exit menu configuration.
* Switch between information windows.

e Use with the Shift key to browse down the events list.
7. Shift:

e Under GUI, press to return a trace to original size without any zoom.

e Activate the integration function by pressing this key together with other keys.

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual 13
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Section 3. Basic OTDR Information

Principle of OTDRs

An OTDR (Optical Time Domain Reflectometer) is a measurement instrument for identifying
optical fiber transmission features. The OTDR is used to measure the overall attenuation of a

fiber optic link and to provide details relating to the position of each event in that link. Events
include splices, connectors, bends, and optical components. Its non-destructive, single-ended
connection and rapid measurement have made the OTDR an indispensable tool for manufacturing,
construction, and maintenance of optical fiber links.

The faults and heterogeneity of optical fiber itself cause Rayleigh scattering of light transmitted in
optical fiber. Part of the light pulse is scattered in the reverse direction, and this is called Rayleigh
backscattering, which actually provides attenuation details relating to fiber length.

Information relating to distance is obtained through time information (thus “time domain” in the
name OTDR). Fresnel reflection occurs at the boundary between two media of different IOR (for
example, connections of faults, connectors, or optical fiber end). This reflection is used to locate
the discontinuous points on optical fiber. The magnitude of reflection depends on the difference
between IOR and the smoothness of boundary.

An OTDR sends out a light pulse into the optical fiber and receives reflections of events and
backscattering power of the pulse in time. Locations will be displayed on the LCD. The y-axis is
the dB value of backscattering power, and the x-axis is the distance.

Basic Definition and Classification of Events

Events refer to any abnormal points causing attenuation or sudden change of scattering power
besides the normal scattering of optical fiber, which include losses such as bending, connections,
and ruptures.

Event points displayed on the LCD are abnormal points that cause traces to deviate from a straight
line.

Events can be classified as reflection events or non-reflection events.

Reflection Events

When some pulse energy is scattered, reflection events occur. When reflection events occur, a peak
is displayed on the trace (Figure 3-1).

Figure 3-1. Reflection Event

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual 15



Section 3

Non-reflection Events

Non-reflection events occur at certain points where there is some optic loss but no light scattering.
When non-reflection events occur, a power drop shows on the trace (Figure 3-2).

Figure 3-2. Non-reflection Event

Inspection of Events

The 930XC OTDR sends a light pulse into the optical fiber to be inspected, receives returning
light signals, and starts calculating the event distance. The farther the distance is, the longer the
time needed for scattered light to be received by the instrument. Event distance can be calculated
according to the time of receiving events signals.

Through the inspection of scattered signals, properties of optical fiber, connectors, and tie-ins can
be identified.

Measurement Application

The 930XC instruments display power relating to the distance of returning signals. This
information can be used to identify the main properties of an optical fiber chain.

Measurement Contents

* Event location (distance), end, or rupture of optical fiber chain.

e Attenuation coefficient of fiber.

* Loss of a single event (for example, one optic tie-in), or total loss from upper end to end.
* Range of a single event like reflection of connectors (or grade of reflection).

* Auto measurement of cumulative loss of a single event.

Trace Analysis

The trace analysis of the 930XC OTDR is fully automatic. The trace locates:
¢ Reflection events of connections and mechanical tie-ins.
e Non-reflection events.
e End of optical fiber.

» Through scanning the first loss event that is larger than the end threshold, identifies the end of
optical fiber.

e Events list: Event type, loss, reflection, and distance.
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Trace Display Screen

The trace displays on the 930XC screen (Figure 3-3).

CELT -

Trace Display —

b
—— Menu
Window ey Bar
| b4
i i ny
8Km/Div 5.00dB/Div tracel Event t
. | No.:2/4 N Location: 25.308km
Information — Refi.<-38.12dB Ins.l: 0.85dB (@
Attn.:0.22dB/km Cum.l: $5.57dB | fl]

Figure 3-3. Trace Display Screen

Trace Display Window
This window displays the trace after one measurement.

Definition of trace: After one measurement, the reflection power diagram will be displayed as a
distance function. This diagram is referred to as trace.

The trace of the 930X C displays measurement results in a graphic form. The y-axis represents the
power while the x-axis represents the distance (Figure 3-4).

Reffection
o :

k Attenuatlon i \\

-

Relative Power

(T

Figure 3-4. Traces and Coordinates
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Information Window

The contents of this window are measurement parameters, events list, marker A/B, and analysis
parameters.

Measurement Trace Parameters

Important measurement and analysis parameters are displayed in the information window
(Figures 3-5a and 3-5b).

8Km/Div 5.00dB/Div tracel Para-1

8Km/Div 5.00dB/Div tracel Para-2

g 3eds s wRON

B edas s o wRON

IAvg.Time: 30s Samp.Dist.: 5.11m Date: 27-May-2005 09:15

Range: 80km PulseWidth: 2.5us NRefl.Thre.: 0.20 End Thre.: 3.00

TOR : 1.4659 Wavelength: 1550nm Refl. Thre.: .52.00 Seni-Cesi: <S030
Figure 3-5a. Measurement Trace Parameters Figure 3-5b. Analysis Trace Parameters

For definitions and configurations of items in Figure 3-5a (average time, sample distance, range,
IOR, wavelength, and pulse width) as well as definitions of items in Figure 3-5b (date, reflection
threshold, non-reflection threshold, end threshold, and scattering coefficient), refer to “Parameter
Configuration” in this section of the manual.

Events List

The events list indicates the location of events inspected. Any defined posts will be displayed in
the events list (for example, a non-reflection event such as a fusion splice or a reflection event such
as a connector) (Figure 3-6).

UELT -

8Km/Div 5.00dB/Div tracel Event

No.: 2/4 .  Location: 25.308km
Refl.:-38.12dB Ins.L.: 0.85dB

Attn.: 0.22dB/km Cum.L.: 5.57dB

T - :@@mﬁ

Figure 3-6. Events List

* No.: Event sequence number.

* Four types of events: - begin end; IL reflection event; — fiber end; "L attentuation event.
e Location: Distance from beginning point to event.

e Refl.: Magnitude of reflection.

e Ins.L.: Loss of inserted event.

e Attn.: Attenuation characteristic from one event point to the current event.

e Cum.L.: Cumulative loss, calculating from beginning point to the current event.
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Marker A/B Information

A marker is used to mark and analyze a single event, trace section, and distance. Distance,
attenuation, and loss at a marker or between markers will be displayed in marker information
(Figure 3-7).

8Km/Div 5.00dB/Div tracel
A-B: 9.274km

2Pt.Loss : 1.71dB
2Pt.Atten: 0.18dB/km

§ 3% o DEUOE

Figure 3-7. Marker A/B Information

The following parameters are measured between marker A and B. Changing either marker will
change the record accordingly.

¢ A-B: Distance between two markers.
e 2Pt. Loss: Loss between two markers; power difference between two markers.

e 2Pt. Atten: 2 points loss of unit length.
The specific operations of the above items are explained in more detail later in this manual.
Fiber Information

Fiber information includes total attenuation, length, and loss of the tested fiber (Figure 3-8)

B 1628

8Km/Div 5.00dB/Div tracel Fiber
File: tracel

Total Attn.: 0.24dB/km
Length: 62.180km Loss: 14.92dB

£ 3¢dinr IpuON

Figure 3-8. Fiber Information
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Menu Bar and Icons

No. Icons Description
1 Vi Parameter configuration
2 () Save file
3 = Open file
4 Ell Re-analyze the trace
5 7k Zoom out trace horizontally
6 a3 Zoom in trace horizontally
7 nx Zoom out trace vertically
8 $ Zoom in trace vertically
9 Ag Switch between markers
10 - Review events list upward
11 <+ Review events list downward
12 iy Battery power indicator

Notes:

e Under the Help menu, only numbers 1 and 3 are operational.

* In the process of measurement, all functions on the menu bar will be disabled.

e Numbers 3,4, 5,6,7,8, and 9 are tools for trace analysis. Numbers 10 and 11 are tools for

reviewing events list.

e Number 1 is explained in the next section, “Parameter Configuration.”

Parameter Configuration

Correct parameter configuration is necessary for accurate measurements.

Use A and ¥ to highlight /2 (i.e., parameter configuration on the menu bar), and then press

Enter (Figure 3-9). Press K to exit.

T 5 53 4+ -&-WA&J@

] ; TR
3
[Range NI J Scat.Coef. -82.0dB
fmme e g et
wvg. Time 30s E ; ;
Wavelength 1550 nm %u ][S)rl[lj Th li:»»l 3.00dB
. eraci clete File
Meas. Mode Averaging > Time(y-m-d) 2005-05-27 10:30:20
PM/LS T 5
: « Auto Off L
Length Units 11\/Iilée6ré (m] [bs Language English
Soat. Coet -52.1dB R LCD Contrast
¢ | Nrefl Thre. 0.20dB LEE EUI'ZfDM?‘del Color 2
5 | Refl. Thre. 252 .00dB b [y Loa efault
2 | End Thre 3,00 dB W e
(O - 1.4000 Wavelengul - 1oov nm | LUK : 1.40/1/ wavelengin: 13>0nm

Figure 3-9. Parameter Configuration
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Definitions of Measurement Parameters

Parameter Definition
Range Length of optical fiber relevant to the trace
Pulse Width Width of laser pulse sent out from OTDR to optical fiber
Average Time Select suitable testing time
Wavelength Select laser wavelength for measurement
Measurement Mode Select mode for measurement
PM/LS Optical power meter, stabilized laser source, and VFL
Length Units Select units of measurement
IOR IOR of optical fiber which affects the transmission speed of laser
Scatter Coefficient Affects backscatter power of laser in fiber
Non-reflection Events whose insertion loss is > the threshold displayed here
Threshold
Reflection Threshold Reflection events > the threshold displayed here
End Threshold First event with insertion loss = the threshold is considered the end of
fiber, and all following events will be ignored
Delete File Delete stored trace data in the instrument
Time Show current system time
Auto Off Enable or disable auto off function
Lang./ % & Choose language
LCD Contrast Adjust contrast of LCD
Color Mode Select suitable color setting for display
Load Default Set all parameters to factory setting
Help Show Help files (quick reference)

Range Configuration

Generally, the range is set according to the actual length of optical fiber in order to insure the
accuracy of the measurement.

Under the parameter configuration menu use A and ¥ to highlight “Range.” Press Enter to select
a range (Figure 3-10). Press K7 to exit.

o : ‘
2
5
k PulseWidth 300 m 5
Avg Time 1.3km z
Wavelength 2 Skm E
Meas.Mode 5km 5
PM/LS 10 km 1
Length Units 20 km 12
+
TR L:
cat. Coet.
| 80 knr
s | Nrefl Thre. 160 k:n :
A | Refl. Thre. 240 km Vi
R | End Thre.
ok 1.4b00 wavelengtn  :  123>U nm | (il

Figure 3-10. Range Configuration

Use A and 'V to select an adequate range. Press Enter to confirm.
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Notes:

e “Auto” means automatic measurement. When this function is selected, the instrument
automatically selects an adequate range and pulse width for the measurement. The process of
measurement does not require any intervention by the user.

e “Auto” is the default setting.

Pulse Width Configuration

The selection of pulse width affects the dynamic range and resolution of the measurement. With
a narrow pulse width there will be higher resolution and smaller deadzone; however, the dynamic
range will be decreased. A wide pulse width will bring higher dynamic range and measure
comparatively longer distance, but resolution and deadzone will be increased. Therefore, users
should make the choice between dynamic range and deadzone.

The options for pulse width will change according to the distance range selected.

Under the parameter configuration menu use A and V¥ to highlight “PulseWidth.” Press Enter to
select a value (Figure 3-11). Press K to exit.

i iy
Range 30 ns jj
| T Bom ] e
Ave Ti 100 ns s
v Time
300 ns B
Wavelength 1 Ous =
Meas Mode 5 ' 5 KZ E
PM/LS : ¥
Length Units Meter [m] 1
IOR 1.4666 v
|| Scat. Coef. -52.1dB A
¢ | Nrefl Thre. 0.20dB r
_A Refl Thre. -52.00dB -
R | End Thre. 3.00dB B
IOk 1.4000 wavelengmn 1 155u nm il

Figure 3-11. Pulse Width Configuration

Use A and V¥ to highlight the pulse width. Press Enter to confirm.

Notes:
e “Auto” is the default setting.

*  When the range is set to “Auto,” the pulse width automatically is set to “Auto.”

Average Time Configuration

Average time will affect the SNR directly. The longer the average time is, the higher SNR is, as
well as dynamic range. Therefore, when measuring long-distance optical fiber, a long average time
should be selected in order to review events at the long-distance end.

Under the parameter configuration menu use A and V¥ to highlight “Avg. Time.” Press Enter to
confirm (Figure 3-12). Press K to exit.
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TR
Range ?
&, PulseWidth =
il Ave. Time o =
Wavelength 1 min 2
Meas.Mode 2 min -
PM/LS 3 min I
Length Units 12
IOR 1.4666 i
Scat.Coef, -52.1dB §
¢ | Nrefl Thre. 0.20dB :
2 Refl.Thre. -52.00dB y
R | End Thre. 3.00dB B
IOk 1.4000 wavelengin 1250 nm (]

Figure 3-12. Average Time Configuration

Use A and ¥ to highlight the desired time. Press Enter to confirm.

Notes:
e There are five levels of predefined average time: 15 s, 30 s, 1 min, 2 min, and 3 min.
e The default setting is “30 s.”

Wavelength Configuration

Under the parameter configuration menu use A and V¥ to highlight “Wavelength.” Press Enter to
change the wavelength (Figure 3-13).

[ ng

Range Auto =

K PulseWidth Auto =
" | Avg.Time 1310 nm =
:
Meas. Mode Averaging 3
PM/LS e
Length Units Meter [m] *
IOR 1.4666 =

|| Scat. Coef. -52.1dB *
| ¢ | Nrefl. Thre. 0.20 dB r
A | Refl. Thre, -52 .00dB vl
R | End Thre. 3.00dB B
T 1.4000 wavelengu 133U nm | ullll

Figure 3-13. Wavelength Configuration

Measurement Mode Configuration

There are two kinds of measurement mode: averaging and realtime. Under realtime mode the
930XC will undertake realtime measurement for the connector of exterior fiber and refurbish the
measured trace. While under realtime mode, press Run/Stop to stop; otherwise it will measure
continuously. Under Averaging mode the tool will average the data within the measure time, which
is set by the user. When exceeding the set time, it will stop automatically and display the result. In
general, averaging is the preferred mode.

Under the parameter configuration menu use A and ¥ to highlight “Meas. Mode.” Press Enter to
select “Averaging” or “Realtime” mode (Figure 3-14). Press K to exit.
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o AT uumﬂ

TR
Range Auto

M PulseWidth Auto
AvgTime 30s
Wavelength 1550 nm
icas \ioae UM
PM/LS
Length Units Meter [m]
IOR 1.4666

|| Scat.Coef. -52.1dB

| ¢ | Nrefl.Thre. 0.20dB

A | Refl. Thre. -52.004B

R | End Thre. 3.00dB

ok 1.4000 wavelength 155U nm (il

Figure 3-14. Measurement Mode Configuration

Power Meter, Laser Source, and VFL Configuration

Under the parameter configuration use A and V¥ to highlight “PM/LS” and press Enter to enter
PMV/LS interface (Figure 3-15). Refer to “Power Meter, Laser Source, and VFL Settings” in

Section 4 for details.

Range Auto

|| PulseWidth Auto

L Avg Time 30s
Wavelength 1550 nm
Meas. Mode Averaging

,

Length Units Meter [m]
IOR 1.46606
Scat. Coef. -52.1dB

| s | Nrefl. Thre. 0.20dB

o | Refl. Thre. -52.00dB

R | End Thre. 3 00dB

IOKR 1.4000 wavelength 1350 nm

IE* 2T v ey 2 +A%‘MJ1M@

Cw

1310nm \Sr;i

Ref: -1(:00dBm 'yl
-20.185

e Y ]

Figure 3-15. Power Meter and Laser Source Configuration

Length Units

Under the parameter configuration menu use A and V¥ to highlight “Length Units.” Press Enter
to select the desired units of measurement (Figure 3-16). Press K to exit.

=P

Range
PulseWidth
Avg Time
Wavelength
Meas. Mode
PM/LS
IOR

Scat. Coet.
Nrefl. Thre.
Refl. Thre.
End Thre.

Auto
Auto

Feet[ft]

Miles[mi]

IVt [

1.4666
-52.1dB
0.20dB
-52.00dB
3.00dB

X T S o e +Ag§lg;5_qé|

(O 1.4000

wavelengu

T 100U nm il

Figure 3-16. Length Units

Greenlee / A Textron Company



Basic OTDR Information

Index of Refraction (IOR) Configuration

Because IOR is a key factor affecting the speed of laser transmission in optical fiber, the [OR
configuration has a direct impact on the accuracy of measurement. In general, the IOR parameter
is provided by the optical fiber manufacturer, and it can be set to the accuracy of four digits after
the decimal point between 1.0 and 2.0.

Under the parameter configuration menu use A and ¥ to highlight “IOR.” Press Enter to enter a
value (Figure 3-17). Press K to exit.

[ ]
Range Auto -?
k PulseWidth Auto -
Avg.Time 30s g
Wavelength 1550 nm ]-l-
Meas.Mode Averaging N
PM/LS Oft T
Length Units Meter [m] L:
1 Boce |
Scat.Coet. -52.1dB N
¢ | Nrefl Thre. 0.20dB r
A | Refl Thre. -52.00dB t
R | End Thre. 3.00dB B
10K 1.4000 wavelengin 155U nm i

Figure 3-17. IOR Configuration

Use d and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits.
After setting, press Enter to confirm.

Scatter Coefficient Configuration

Scatter coefficient determines the value of backscatter power. This configuration affects the
calculation of reflection value.

Under the parameter configuration menu use A and V¥ to highlight “Scat. Coef.” Press Enter to
enter a value (Figure 3-18). Press K to exit.

Range Auto J
k PulseWidth Auto =
Avglime 30s ﬂl
Wavelength 1550 nm =1
Meas. Mode Averaging »
PM/LS Oft .
Length Units Meter [m] '
IOR 1.4666 Y
u 5p.1dB -
Nrefl. Thre. 0.20 dB r
A | Refl. Thre. -52.00dB -
R | End Thre. 3.00 dB Vg
ok 1.4000 wavelengin 150u nm il

Figure 3-18. Scatter Coefficient Configuration

Use <« and P> to adjust the position of the highlighted area. Use A and V¥ to change the digits.
After setting, press Enter to confirm.
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Non-reflection Threshold Configuration

This configuration has direct impact on the listing of insertion loss events. Only events = to this

threshold will be listed.

Under the parameter configuration menu use A and V¥ to highlight “Nrefl. Thre.” Press Enter to

enter a value (Figure 3-19). Press K to exit.

T ‘
Range Auto -?
& PulseWidth Auto e
Avg. Time 30s
Wavelength 1550 nm ﬂl
Meas.Mode Averaging 1
PM/LS Oft T
Length Units Meter [m] B
IOR 1.4666 :
Scat.Coef. -52.1dB %
E €.20dB r
4 | ReflThre. -52.00 dB o
R | End Thre. 3.00dB ¥
[OR 1.4000 wavelength 1530 nm (il

Figure 3-19. Non-reflection Threshold Configuration

Use d and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits.

After setting, press Enter to confirm.

Note: The default setting is “0.20 dB.”

Reflection Threshold Configuration

This configuration has direct impact on reflection events listing. Only reflection events > to this

threshold will be displayed in the events list.

Under the parameter configuration menu use A and V¥ to highlight “Refl. Thre.” Press Enter to

enter a value (Figure 3-20). Press K to exit.

G T s o ety gl

TR
Range Auto
k PulseWidth Auto
Avg Time 30s
Wavelength 1550 nm
Meas.Mode Averaging
PM/LS Oft
Length Units Meter [m]
IOR 1.4666
|| Scat. Coet. -52.1dB
¢ | Nrefl. Thre. 0.20 dB
A B .004B |
R | End Thre. 3.00dB
1(ST 1.4000 wavelengin 155U nm  {iify

Figure 3-20. Reflection Threshold Configuration

Use <« and P> to adjust the position of the highlighted area. Use A and V¥ to change the digits.

After setting, press Enter to confirm.

Note: The default setting is “-52.00 dB.”
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End Threshold Configuration

This threshold is the end threshold of optical fiber. If the end threshold equals 3.0 dB, then the first
event with insertion loss = 3 dB will be considered the end of the optical fiber. If the value is set to
0 dB, there will be no end threshold.

Under the parameter configuration menu use A and ¥ to highlight “End Thre.” Press Enter to
enter a value (Figure 3-21). Press K to exit.

i —
Range Auto -?
‘\ PulseWidth Auto z
Avg.Time 30s
Wavelength 15350 nm 5“'
Meas . Mode Averaging 3
PM/LS Oft L
Length Units Meter [m] .
IOR 1.4666 S
Scat. Coef. -52.1dB +
¢ | Nrefl. Thre. 0.20 dB r
"\ | Refl The. -52.00dB F
A B i00d e
Iox 1.4000 wavelengin  : 13du nm |(ill]

Figure 3-21. End Threshold Configuration
Use € and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits.
After setting, press Enter to confirm.

Note: The default setting is “03.00 dB.”
Delete File
This function deletes saved traces.

Under the parameter configuration menu use A and V¥ to highlight “Delete File.” Press Enter to
enter (Figure 3-22). Press K to exit.

Range Auto .-g
Select File:0 118/1000 =
lrace00] 27-May-2013 10:30 gl
Trace002 Range: 8§0km ot
Trace003 Pwidth: 2.5us :.:
Trace004 Wavelen.: 1550nm | 25
Trace005 *
Trace006 [Delete |[Cancel | || ¥
Trace007 I T
Trace008 | SelAll |[Format || g
B

IUK @ 1.4000 wavelengtn: 13>unm |{ill

Figure 3-22. Delete File

Use A and ¥ to choose the files to delete, and press Enter to confirm. Or use the arrow keys to
choose “SelAll,” and press Enter to select all files.

One or several files can be deleted at a time. Use the arrow keys to select “Delete.” Press Enter,
and choose “Yes” to delete or “No” to not delete. Choosing “Cancel” will exit the Delete menu.
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Format Memory

Press format memory to format the internal memory.

Range Auto .a
Sel et
Warning: ) =

Trad LOW-level format may gl
T damage flash memory, N
4% continue? P n
Tra Kol |l
Trag/ No b
Trag Yes D i
Tra L
| 2

Y8

[IUK : 1.4b00 wavelengin: 13>unm | (il

Figure 3-22a. Format Memory

Time Configuration
Time configuration is used to change system time.

Under the parameter configuration menu use A and V¥ to highlight “Time (y-m-d).” Press Enter
to change (Figure 3-23). Press K to exit.

[y ]
Avg. Time 30s ?
k Wavelength 1550 nm =
Meas. Mode Averaging Ell
PM/LS ) Oft -1
Length Units Meter [m] ¥
IOR 1.4666 .
Scat. Coef. -52.1dB -
Nrefl. Thre. 0.20 dB M
Refl. Thre. -52.00dB *
¢ | End Thre. 3.00dB r
Z Delete File _ 4
N Timc SRl o[F-05-2710 :30:20 | | 4
oK 1.4000 wavelength  :  IDdU nm il

Figure 3-23. Time Configuration

Use d and P> to adjust the position of the highlighted area. Use A and ¥ to change the digits.
After setting, press Enter to confirm.
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Auto Off Configuration

This function conserves battery power. When auto off is enabled, the instrument will automatically
power off when idle for 5 minutes.

Under the parameter configuration menu use A and V¥ to highlight “Auto Off.” Press Enter to
switch between “Off” and “On” (Figure 3-24). Press K to exit.

Co -
Wavelength 1550 nm -?
‘\ Meas. Mode Averaging =
PM/LS Oft El-l-
Length Units Meter [m] fL
IOR 1.4666 B
Scat. Coef . -52 . 1dB T
Nrefl. Thre. 0.20dB .
Refl. Thre. -52.00dB Y
End Thre. 3.00dB +
| s | Delete File r
[ | Time (y-m-d) 2005 -05-27 10 :30:20
R Off B
ok 1.4000 wavelengtn 1350 nm- (il

Figure 3-24. Auto Off Configuration

Note: The default setting is “On.”

Language Configuration
There are two language options: English and Chinese.

Under the parameter configuration menu use A and V¥ to highlight “Lang./ ¥ 7.” Press Enter to

switch the language (Figure 3-25). Press K to exit.

T
]
Meas. Mode Averaging J
k PM/LS Oft =
Length Units Meter [m] =
TOR 1.4666 =l
Scat. Coef. -52.1dB 5
Nrefl. Thre. 0.20dB L
Refl. Thre. -52.00dB .
End Thre. 3.00dB :
Delete File +
[ ¢ | Time(y-m-d) 2005 -05-27 10 :30:20 [ o
2 Auto Off Off (4
R English VB
Ior 1.4000 wavelength 1330 nm (il

Figure 3-25. Language Configuration
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Contrast Adjustment of LCD

The contrast of the LCD can be adjusted.

Under the parameter configuration menu use A and V¥ to highlight “LCD Contrast.” Press Enter
to adjust (Figure 3-26). Press K to exit.

- B

PM/LS Oft J

k' Length Units Meter [m] "
- | IOR 1.4666 4
Scat. Coef. -52 .1dB =l
Nrefl. Thre. 0.20dB I
Refl. Thre. -52 .00dB ﬂ:
End Thre. 3.00dB I
Delete File :
Time(y-m-d) 2005 -05-27 10 :30:20 t+

7{ Auto Off Low ngh ~
e E—]
AllLCD coniast v
[IOR 1.4600 Wavelength @ 1330 nm Il

Figure 3-26. Contrast Adjustment of LCD

Use d and P> to adjust the contrast. After adjusting, press Enter to confirm.

Color Mode Setting
This setting changes the color scheme of the display.

Under the parameter configuration menu use A and V¥ to highlight “Color Mode.” Press Enter to
choose a different mode (Figure 3-27). Press K to exit.

= 3
Length Units Meter[m] %
\ IOR 1.4677 2
" [Scat.Coef. -82.0dB =
Nrefl.Thre. 0.20dB %
Refl. Thre.  -52.00dB 3
End Thre. 3.00dB n
Delete File 12
Time(y-m-d) 2005-05-27 10:30:20 :
Auto Off Colorl *
g{Lang./iE S Colotr2 r
4 [LCD Contrast Color3 | 2
Color Modc Black/White B
[OK 140/ wavelengin: 1>>unm |

Figure 3-27. Color Mode Setting

Use A and V¥ to highlight the desired color mode setting. Press Enter to confirm the selection.
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Default Setting

This function is used to set the OTDR parameters to factory settings. These parameters include:
range, pulse width, average time, IOR, non-reflection threshold, reflection threshold, end
threshold, and scatter coefficient.

Under the parameter configuration menu use A and V¥ to highlight “Load Default.” Press Enter
to enter (Figure 3-28). Press K to exit.

RO ?‘

IOR 1.4677 a

[ |Scat.Coef. -82.0dB -
“|Nrefl.Thre. 0.20dB =
Refl.Thre. -52.00dB o
End Thre. 3.00dB 5
Delete File n
Time(y-m-d) 2005-05-27 10:30:20 .
Auto Off off 1
Lang./if 77 English 1
§|LCD Contrast r
i Color Mode [
5 Ves Yo
UK 1.40/ ¢ wavelengin: 13>3Unm | i

Figure 3-28. Default Setting

Use A and 'V to highlight “Yes” or “No.” Press Enter to confirm.

Help
The Help function provides access to the quick reference screen.

Under the parameter configuration menu use A and V¥ to highlight “Help.” Press Enter to display
the quick reference screen (Figure 3-29). Press K to exit.

[0 5a ] -g
Scat.Coecf. -82.0dB 2
i Nrefl.Thre. 0.20dB e
"|Refl.Thre. -52.00dB 9
End Thre.  3.00dB 2l
Delete File _l-
Time(y-m-d) 2005-05-27 10:30:20 n
Auto Off Off 2
Bang it = English :
LCD Contrast 2
§|Color Mode Color 2 r
Load Default | o
A
R !
[OR L4017/ wavelengin: 1>>unm | iy
Quick reference Quick reference
1. Connect the fiber and OTDR. 6. Press dorpto move active marker.
2. Press A orwtoselect icon. Press 7. Select {}or §& to zoom trace
‘Enter’ to activate function. horizontally, and select [Xor n¥
3. Select/2to set parameters: IOR, to zoom trace vertically.
Scat. Coef., pulsewidth, range, 8. SelectAs to switch markers.
avg.Time, Refl. Thre., NonRefl. Thre 9. Select®or$to browse event.
and End Thre etc. 10.Select ™ to save files.
4. Press ‘Run/Stop’ to start... 11.Select (2 to open saved files.
5. Press K1to view measure results. Warning: Always Avoid Naked Eyes
Exposed to Laser!
(4Page Up P Page Down XJQuit) (4Page Up P Page Down XK¥Quit)

Figure 3-29. Help
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Section 3

Battery Recharge Status

When the 930XC is powered off and powered through the AC/DC adapter, the “CHARGE”
indicator on the interface panel (Figure 2-1) will be lit. When the battery is fully recharged, the
indicator will turn off.

When the instrument is powered on and powered through the AC/DC adapter, the internal battery
is automatically recharged. The icons mean the following:

Battery is being recharged

EI Battery is fully charged

When the 930XC is powered by the internal rechargeable battery, the power level of the battery is
shown on the LCD:

EI No power
EI Low power
m Half power

@I More than half power

@I Full power
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Section 4. Trace Measurement and Processing
of Existing Traces

Graphical User Interface (GUI) Instructions

When the 930XC is first turned on, an introductory screen appears on the LCD (Figure 4-1).

GREENLEE.

COMMUNICATIONS

930XC-XXX

--- Version X.X ---

SSSSS5S5555S55555>5>5>>

Figure 4-1. Power On Screen

Three seconds after the instrument is turned on, a quick reference screen appears (Figure 4-2).

1. Connect fiber to optical port.

2. Press ‘Run/Stop’ to start... %l

3. @ or & to browse event table Jj

K) to view trace parameters I

) ks

Avoid Eyes Exposed to Laser! e

*

@*

--Km/Div --dB/Div Para-1 3

Ave.Time: --s Samp.Dist.: -- Mg
Range: --km PulseWidth: ---

IOR g =,===< Wavelength: ----nm|@m

Figure 4-2. Quick Reference Screen
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Section 4

Trace Measurement

One complete trace can be obtained for each measurement. The 930XC can also load a saved
trace.

ACAUTION

Instrument damage hazard:

Make sure that the optical fiber or cable is not in use and there is no laser beam in the fiber
before testing with this unit.

Failure to observe this precaution may result in injury and may damage the unit.

Setup

Connect the optical fiber directly to the 930XC optic output. No tools are required.
e Clean the connectors. Refer to Section 5 of this manual for details.
¢ Clean the tie-ins, making sure they are compatible (APC or UPC).
* Connect optical fiber to the 930XC.

For details relating to parameter configuration, refer to “Parameter Configuration” in Section 3. If
the parameters are unclear, use the default parameters of the instrument.

Note: Range is set to “Auto” when auto measurement is on.

Auto Trace Measurement

Auto measurement can be used if the length of optical fiber is unknown. The 930XC will select an
adequate range for measurement.

For auto measurement follow these steps:
1. Set the range to “Auto.” Refer to “Parameter Configuration” in Section 3.

2. Press Run/Stop to start the measurement (Figure 4-3).

© B 39628

B
N
)
N

JePLR*
B 3edanroEes

»
-,

W

‘ - : :
8Km/Div 5.00dB/Div = *

--Km/Div --dB/Div

Ave.Time : 00:30 Ave.Time : 00:30 e

Time Passed: 00:16 Time Passed: 00:30 yzing
m

Figure 4-3. Measuring

3. Interface:
e Ave. Time: 00:30: Measure time, which is set by user, is 30 seconds.
* Time Elapsed: 00:16: Total measurement time has passed 16 seconds.

 ¥—: Blinking of this icon means laser is active.
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Trace Measurement and Processing of Existing Traces

Note: After a certain period of time, the trace displays on the GUI. The trace in the figure
below is a trace during measurement, which will be refreshed for every certain period of time
to demonstrate the whole process in realtime. But at the end of measurement the trace will be
complete, as shown in Figure 4-4.

CELT -

8Km/Div 5.00dB.f'Div tracel Event

g g{-»aa# ::@Eﬁﬁ

No.: 2/4 N Location: 25.308km
Refl.:-38.12dB Ins.L.: 0.85dB
Attn.: 0.22dB/km Cum.I..: 5.57dB

Figure 4-4. Trace Measurement

Manual Trace Measurement
To achieve optimal measurement results, set the parameters manually.
1. Set the range. Refer to “Range Configuration” in Section 3.

2. Press Run/Stop to start the measurement. The process is the same as with auto measurement.

Live Traffic Warning

If the 930X C is connected to a fiber with live traffic, the warning of “Traffic Signal Detected!”
will be displayed after Run/Stop is activated. Disconnect the fiber under test and quit the
measurement. To avoid damage to the 930XC, ensure that live traffic is removed from the test
fiber before reconnecting to the 930XC.

1. Connect fiber to optical port
2. Press ‘Run/Stop’ to start

3 Traffic Signal Detected !
'

Avoid Eyes Exposed to Laser !

EI SRR

--Km /Div_--dB/Div Para-1
Ave.Time: --s Samp. Dist.: --
Range: --km Pulse Width: ---
I0R : S Wavelength: ----nm

Figure 4-5. Live Traffic Warning

Reasons for Trace Measurement Failures

If measurement failures occur, the reason may be one of the following:

* Events may be too close to each other: Shorten the pulse width and try again. If failure still
occurs, try measuring at the other end of the optical fiber.

* Low SNR: Use a wider pulse or increase average time and try again.

e Incorrect parameter configuration: Check the parameter configuration and try again.
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Section 4

Information Window

Zoom a Trace

36

The information window displays the following items: measurement parameters, analysis
parameters, and information regarding marker A/B.

For details regarding the information window, refer to “Information Window” in Section 3.

Switching between Information Window ltems

Under GUI (Figure 4-4) press K and the items in the information window will display in this
order: measurement parameters = analysis information = events list = marker A/B information
- fiber information = measurement parameters.

Reviewing Events List

Under GUI (Figure 4-4) press K7 until the events list information appears in the information
window.

Use A and V¥ to highlight T or !, and then press Enter to review the events list. Use T to browse
upward, and | to browse downward. To browse up and down the events list using the keypad,
press Shift + K7 and Shift + Enter.

Reviewing Marker A/B Information

Switching between Marker A/B

Under GUI (Figure 4-4) use A and V¥ to highlight A8, and then press Enter to switch betweeen
marker A/B.

Use 4 and P> to move marker A or B.

Information between Marker A/B
Under GUI (Figure 4-4) press K1 to switch the information window to marker A/B information.

Use d or P to change the position of marker A or B, and the marker A/B information will change
accordingly in the information window.

Zoom out Trace Horizontally

To review the details of an event more closely, follow these steps:

1. Under GUI (Figure 4-4) use A and ¥ to highlight 3%, and then press Enter to zoom out the
trace horizontally.

2. Use dor P to move the marker to the event point being reviewed.

3. Refer to “Switching between Marker A/B” above for more information.

Zoom in Trace Horizontally

Under GUI (Figure 4-4) use A and 'V to highlight £3, and then press Enter to zoom in the trace
horizontally.
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Trace Measurement and Processing of Existing Traces

Zoom out Trace Vertically

To review the details of an event more closely, follow these steps:

1. Under GUI (Figure 4-4) use A and V¥ to highlight %, and then press Enter to zoom out the
trace vertically.

2. Use 4 or P to move the marker to the event point being reviewed.

3. Refer to “Switching between Marker A/B” above for more information.

Zoom in Trace Vertically

Under GUI (Figure 4-4) use A and V¥ to highlight [I¥, and then press Enter to zoom in the trace
vertically.

Zooming Shortcuts
e To zoom in horizontally using the keypad, press Shift + P>
 To zoom out horizontally using the keypad, press Shift + <.
e To zoom in vertically using the keypad, press Shift + A.
e To zoom out vertically using the keypad, press Shift + Enter.

Re-analyze a Trace

Save a Trace

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual

If the test result at a certain threshold is not adequate, it can be re-analyzed using this function to
change the threshold. This function can be effective while the OTDR is disconnected from the
fiber.

Under the parameter configuration menu edit the threshold value, and then press K7 to exit the
parameter configuration menu. Press [E]l to re-analyze the trace.

When auto or manual measurement is finished, the measurement trace can be saved. The contents
of a saved trace include the trace curve and related information of the trace.

1. Under GUI (Figure 4-4) use A and V¥ to highlight &, and then press Enter to enter
(Figure 4-6).
|
Sp[acc Usled: 118/1000
[RACEO |
ABCDEFGHIJKLM

NOPQRSHMUVWXYZ
0123456789

990y

X953 W HEN

= l Save ||Cancel|| Del | —
8Km/ a-1 |
Avg.Time: 30s Samp.Dist.: 5.11lm
Range: §0km PulseWidth: 2.5us

IOR : 1.4666 Wavelength: 1550nm |@nl

Figure 4-6. Save a Trace
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Section 4

2. Input file name: Use A, ¥, 4, and P> to choose the alphanumeric characters one by one, and
then press Enter to confirm. The filename can be a maximum of eight characters in length.

3. Savefile: Use A, ¥, 4, and P> to highlight “OK,” and then press Enter to save.

4. Cancel saving file: Use A, ¥, 4, and P> to highlight “Cancel,” and then press Enter to
cancel the save file operation.

5. Delete alphanumeric characters: Use A, ¥, <, and P> to highlight “Delete,” and then press
Enter to delete the characters.

6. Memory space: “118/1000” means that total memory space is 1000 files; 118 files have been
saved so far.

Browse Saved Traces

1. Under GUI (Figure 4-4) use A and ¥ to highlight (2, and then press Enter to confirm
(Figure 4-7).

Hﬁ“m
| g
Select File: 118/1000 =
27-May-2013 10:30 ||Z]
Trace002 Range: 80km Il
Trace003 Pwidth: 2.5us || qL
Trace004 Wavelen.: 1550nm n
Trace005 e
~ |Trace006 I,‘_
| 8Kl Trace007 |
Av|Trace008 | Open ||Cancel| M
Range: 80km PulseWidth: 2.5us |
IOR : 1.4666 Wavelength: 1550nm |l

Figure 4-7. Browse Saved Traces

2. Use A and V¥ to highlight the trace, and then use € and P> to choose “Open” or “Cancel.”
Press Enter to confirm.

3. Memory space: “118/1000” means that total memory space is 1000 files; 118 files have been
saved so far.
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Trace Measurement and Processing of Existing Traces

Alter Measurements in Realtime Testing

To alter measurements in realtime testing, follow these steps:

1. Use A and V¥ to highlight 2 (e., parameter configuration), and then press Enter.
A parameter box will appear at the bottom of the screen.

2. Use € and P> to move to the parameter to be changed (Figure 4-9), and then press Enter.
3. Use A and V¥ to change the value. Select “Averaging” to choose Averaging testing.

4. Press “OK” to exit the parameter configuration menu.

ELLE

o

:]ﬂ@'eﬂ \

+
+,

{
/
o

. *
SOKm/Div 5.00dB/Div * Event 3
Range: JININ PulseWidth: 2.5us M
Wavelength: 1550nm IOR: 1.4666

<Averaging= <0OK= {1l

Figure 4-9. Alter Measurements in Realtime Testing

-]

*
>
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Section 4

Power Meter, Laser Source, and VFL Settings

Optical Power Meter Settings

1.

Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration”
in Section 3. Use A and V¥ to highlight “OPM”, and press Enter to enter OPM interface
(Figure 4-10).

CW &

1310nm VFL

Ref: -10:00dBm k)
-20.185

<4\P [

Figure 4-10. Optical Power Meter

Use d and P> to toggle between calibrated wavelengths. Press Enter to enter OPM
measurement setting interface (Figure 4-11).

CH
1310nm/Fef =10, 00dBm gLs
Ref :—1Init dBm VFL
Load default K
Zero '

_______ Low

dBm
40P {m

Figure 4-11. OPM Measurement Setting

Use A and ¥ to highlight the parameter to be adjusted, and press Enter to enable adjustment.
Press € and P> to adjust digit position, and press A and V¥ to adjust the value. Press Enter
again to confirm and press K1 to exit setting.

Zeroing the Optical Power Meter

1.
2
3
4.
5

40

Isolate OPM port from outside light input with dust cap tightened securely.
Enter “Setup” and find “PM/LS”.

Enter “PM/LS” and select “OPM”.

In OPM interface, press Enter to find OPM popup menu.

Find “Zero”, and press Enter to zero the OPM.
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Trace Measurement and Processing of Existing Traces

Stabilized Laser Source Settings

1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration”
in Section 3. Use A and V¥ to highlight “SLS”, and press Enter to enter SLS interface

(Figure 4-12).

PCW oF
13 10nm VFL
"

Laser Off
4 A\ D {iiil

Figure 4-12. Stabilized Laser Source

2. Use € and P> to toggle between SLS working wavelengths. Press Enter to enter SLS setting
interface (Figure 4-13).

PCW 131 0nm 0PN
131 0nm |Mod PCW 5LS
On/0Fff Off VFL
K

Laser Off
40P i

Figure 4-13. Stabilized Laser Source Setting

3. Use A and V¥ to highlight the parameter to be adjusted, press Enter to confirm, and press K1
to exit setting.
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Section 4

Visible Fault Locator Settings

1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration”
in Section 3. Use A and V¥ to highlight “VFL”, and press Enter to enter VFL interface
(Figure 4-14).

CW OFN
sLE
K
Laser Off
4 Mod p {m
Figure 4-14. Visible Fault Locator
2.

Use d and P> to toggle between VFL working modes. Press Enter to enter VFL setting
interface (Figure 4-15).

CW iCy OFN
On/Off Dff SLS
KT

Laser Off

4 Mod p i
Figure 4-15. Visible Fault Locator Setting

3. Use A and V¥ to highlight the parameter to be adjusted, press Enter to confirm, and press K1

to quit setting.
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Section 5. Calibration and Maintenance

ACAUTION

Electric shock hazard:

o Do not expose the unit to extremes in temperature or high humidity. Refer to
“Specifications”

o Turn the unit off, disconnect from power, and make sure the laser source is off before
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.

Calibration Requirements

Calibration of the instrument is recommended every two years. Contact Greenlee for proper
calibration services.

Maintenance and Replacement of Batteries

The 930XC has two batteries: a NiMH battery to power the instrument and a realtime clock (RTC)
battery for data retention.

Note: Recharge the battery prior to use if the OTDR has not been used for one month.
To replace the NiMH battery (Figure 5-1):

1. Remove the battery compartment cover.

2. Remove the battery and disconnect the battery connector.

3. Replace the battery with the Greenlee supplied replacement battery.

To replace the RTC battery (Figure 5-1):

1. Remove the NiMH battery as above.

2. Remove the RTC coin cell battery.

3. Replace using a CR1220. Insert the replacement coin cell with the positive side facing up.

Jack for y
Chargeable Battery/.-"

Chargeable

/ RTC Clock
Battery

Figure 5-1. Replacing Battery
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Section 5

Cleaning

When necessary, clean the case, front panel, and rubber boot with a damp cloth. Do not use
abrasives, harsh chemicals, or solvents.

Before Cleaning

Make sure the power is off to the instrument.
Make sure the laser source is off when cleaning any optical connectors.

Make sure AC power is disconnected.

Cleaning Interfaces and Connectors

Interfaces must be kept clean. Isopropyl alcohol may be used to clean the optical output. Always
replace the protective dust caps when the unit is not being used, and keep the protective dust caps
clean. In addition, flanges must be cleaned periodically.

Notes:

The diameter of optic core is 9 um, and the diameter of dust and other particulates ranges
from 1/100 to 1/1000 um. Dust and other particulates can cover part of the optical end and
therefore degrade the performance of the instrument.

In addition, power density may burn dust into optical fiber and induce further damage

(for example, 0 dBm optic power may produce about 16000000 W/m*m power density in
single mode fiber). If this happens, the measurement will be inaccurate and damage will be
irreversible.

Tools for Cleaning Interfaces and Connectors

Optical fiber cleaner (for cleaning optical connectors)
Optical fiber cleaning rod (for cleaning optical outputs)
Optical fiber cleaning tissue (for cleaning optical interfaces)
Isopropyl alcohol

Paper tissue

Cleaning brush

Cleaning swabs

Condensed air

Procedure for Cleaning Interfaces and Connectors

1.
2.
3.

44

Unscrew the adapter from the bulkhead.
Carefully clean the bulkhead and the inside of the adapter.

Screw the adapter back onto the bulkhead.

Figure 5-2. Flange
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Section 6. Specifications

Optical Specifications™® 930XC-20C 930XC-20M 930XC-30F | 930XC-30P
Dynamic Range (db)® 35 2124 38/37/37
Wavelength (+20 nm) 1310/1550 850/1300 1310/1550/1625 | 1310/1490/1550
Display Type Color
Fiber Type Single-mode Multi-mode Single-mode
Selectable Ranges (km) 0.3/1.3/2.5/5/10/20/40/ @ 850 nm: 0.3/1.3/2.5/5/10/20/40/

80/160/240 0.1/0.3/0.5/1.3/2.5/5/10; 80/160/240
@ 1300 nm: 0.1/0.3/0.5/

1.3/2.5/5/10/20/40/80

Pulse Widths (ns) 5/10/30/100/300/1000/ @ 850 nm: 5/10/30/100/300/1000/
2500/10000/20000 12/30/100/275/1 ps; 2500/10000/20000
@ 1300 nm:

30/100/275/1 ps/2 ps
Average Time (s) 15/30/60/120/180
Attenuation Deadzone (m)®) <14 <12 <14 <14
Event Deadzone (m)® <25 <25 <2 <25
Sampling Range (m) 0.1to 15 1to 10 0.1to 15
Sampling Points 16000 (maximum)
Distance Measure Accuracy + (1 m+ 5 x 1075 x Distance (m) + sampling space)
Attenuation Measure Accuracy 0.05 dB/dB
Reflection Measure Accuracy +4 dB
Measurement Data Storage 1000 test curves
Connector Type PC,APC PC PC,APC
Data Transmission RS-232/USB port

(1) Specifications describe the instrument’s typical performance, measured with FC/PC-type connectors.
Uncertainties due to the refractive index of fiber are not considered.
(2) The dynamic range is measured using a 1 s (850 nm), 2 us (1300 nm), 20 us pulse, SNR = 1, and an average time of 3 minutes.
(3) Conditions for deadzone measurement: Reflection intensity is less than =35 dB (-20M), —45 dB (-20C), —55 dB (-30X), and a pulse width of 10 ns.

Other Specifications 930X C-20C 930XC-20M 930X C-30F 930X C-30P
Power Supply NiMH chargeable battery/AC adapter
Battery Capacity Supports over 8 hours operation on one charge

or > 20 hours standby
VEL Power -3 dBm
VFL Wavelength 650 nm
Operating Temperature —10°Cto 50 °C (14 °F to 122 °F)
Storage Temperature —20 °C to 60 °C (-4 °F to 140 °F)
Relative Humidity 10% to 90% (non-condensing)
Weight 0.87 kg (19 1b)
Dimensions (H x W x D) 196 mm x 100 mm x 60 mm (7.7 in x 3.9 in x 2.4 in)
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Section 6

Stabilized Laser Source Module

Specification 930XC-20C 930XC-20M 930XC-30F 930XC-30P
Wavelength Same as OTDR working wavelength
Output Power (dBm) >-7
Optical Power Meter Module
Specification 930XC-20C 930XC-20M | 930XC-30F 930XC-30P

Calibrated Wavelength (nm)

850/1300/1310/1490/1550/1625

Power Range (dBm) -70 ~ +6 (-60 ~ +6 @ 850 nm)
Detector Type InGaAs
Display Resolution (dB) 0.01
Accuracy +5% +0.01 nW (0.5 dB @ 850 nm)
MOD Identification 1K,2KHz
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Section 7. OTDR Trace Viewer Software

Trace Viewer software is an application developed for the 930XC OTDR. It allows the previously
stored measurement records in the instrument to be uploaded to a PC and to be displayed, saved,
or printed. This software provides a convenient data management function, which includes:
editing, analysis, browsing, saving, backup, printing, and ASCII format output.

Software Installation

Computer System Requirements

Requirements for operating system and hardware:

PC with Intel Pentium III processor or higher

Microsoft® Windows 98/2000/XP/Vista/7/8 operating system
Minimum 64 MB of internal memory

Minimum 40 MB of available hard disk space

8-speed CD-ROM drive

9-pin series port or USB port

Installation
Follow these steps to install the 930XC OTDR Trace Viewer software on a PC:
1.

2
3
4.
5

Start Microsoft® Windows.

Exit all other running applications that Windows is currently running.

Insert the installation disk into the CD-ROM drive, and locate the OTDR Trace Viewer folder.
Run 930XC OTDR Trace Viewer setup file to install.

Follow the step-by-step installation wizard instructions until installation is complete.
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Section 7

Software GUI

Graphical User Interface (GUI)

After installing the 930XC Trace Viewer software, click “run” to view the main GUI (Figure 7-1).

Greenlee 930XC OTDR Trace Viewer - [] =
] > Fie Edit View OTDR Window Help
2>z adBEl@laa|Tumal~|He|t|z]3]4]
-] Trace [E=] =8 Parameters =EE=]

=] Marker Information | = || & | = |

16
Event Table [=[®]=|| 8 Total FiberInformation [=--&-] = |
No. [Type [ Locati.. | Refl(dB] [Ins.Lossd... | attndgfkm] | Cum.LossL.. | DistPrev.km] [ DistEndlkm] | Loss Prev.dB] | Comment |
«—7
4 >
8>

Figure 7-1. GUI

1. Menu

Tool bar

Trace display window (Spectral line)

Events list window (Events Table)

Measurement and analysis parameter window (Parameter Sheet)
Fiber information window (Fiber section information)

Fiber chain information window (Fiber chain information)

® N s wDd

Status bar
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Trace Viewer Software

Menu, Tool Bar, and Status Bar
The main GUI of the 930XC OTDR Trace Viewer software is shown in Figure 7-1.
The menu bar includes: File, Edit, View, OTDR, Window, and Help.

The tool bar is right below the menu bar. Use the mouse pointer to highlight a tool, and the
operation reference will pop up. The tool bar display can be turned on or off by clicking “Show
Toolbar” under the “View” menu. The tool bar provides shortcut keys to complex operations. All
the functions on the tool bar can also be accessed through the menu bar.

The status bar is at the very bottom of the GUI. It displays information or reference of the current
menu or tool bar application. The status bar is a brief summary of the current menu application or
tool bar function.

File (F)

The functions enabled under the “File” menu (Figure 7-2) include: Upload Trace File, Open,
Multi-traces (add up to four traces to display) , Save, Save As, ASCII Export, Print Option,
Printing Preview, Print, Batch Print Preview, Batch Print, Batch Edit, and Exit.

Fle Edit WView OTDR Windo
Upload Trace File...

ASCIl Export...

Print Option...

Print Preview

Print Setup...

Print... Ctrl+p

Batch Print Praview
Batch Print
Batch Edit

Exit

1 Dermo (4)
2 Demo (3)
3 Demo (2)
4 Demo (1)

Figure 7-2. File Menu

Edit (E)

Use the “Edit” menu (Figure 7-3) to edit the events list: Add Event, Modify Event, Delete Event
and Edit Trace (optical fiber) Information. Optical fiber information is explanatory text relating

to the trace file that users type in. For each measurement, users can save the measurement trace
with the 930X C. This software provides an interface for text input. For each trace file, users can
input related information (No. of cable, No. of fiber, type of fiber, beginning of fiber, end of fiber,
manufacturer, and technician. With this information, users can identify the corresponding relations
between trace file and fiber chain.

Edit View OTDR Window

Add Event
Modify Event
Delete Event

Edit Trace Information...
Figure 7-3. Edit Menu
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Section 7

View (V)

The “View” menu (Figure 7-4) controls the display of the tool bar, status bar, marker operation
and trace display (zoom in and out horizontally and vertically), and the display style of the trace.

View OTDR Window He

v Show Toolbar
v Show Status Bar

Lock Marker A B
Zoom out

View Ful Trace
Analyze Insertion Loss
Analyze Reflactance
Length Units. ..

View Preferences...

Figure 7-4. View Menu

A trace is composed of many dots. To review the details of a trace, zoom in by drawing square
with mouse on selected trace area from upper left to lower right direction and zoom out by
drawing square from any other direction.

Lock Marker A and B to fix the distance between them.

Use “Analyze Insertion Loss” function to manually calculate the insertion loss of an event
(Figure 7-5).

] Trace 0.050 km/Div 2.3 dB/Div E=RECR

OIS | : | 5 .

Figure 7-5. Analyze Insertion Loss

Use “Analyze Reflectance” function to manually measure the reflectance of reflection event
(Figure 7-6).

e Trace 0.050 km/Div 2.3 dB/Div ==
' ‘ : : A 0.62161 kil : ; ; .
_______________ T R R T
v
: >

Figure 7-6. Analyze Reflectance
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Trace Viewer Software

Use the “Length Units” setting to select meters, feet, or miles as the unit of measurement.
Note: When the Trace Viewer application is opened, this setting defaults to the last unit of
measurement selected.

View Preferences refers to the trace display styles. Trace can be displayed in dots or solid line;
dashed line displays or not; selection of the event status bar.

OTDR (O)

The “OTDR” menu (Figures 7-7 and 7-8) provides a reanalysis function for acquired traces.
Operator can modify IOR, Scatter Coefficient, and event thresholds (Non-reflection, Reflection,
and End) per each wavelength to review correct results.

OTDR Window Help

ReAnalysis Event |
Figure 7-7. OTDR Menu

x|
~Acquisition Fiber Settings

Wavelenglh ®
10R ||.4|iﬁs Default

Scal. Coef[dB] |-52_| Default

Analysis Parameters

MNon-Reflection Threshold In_a dB8  Default
Heflection Threshold FE dB  Default
|3 dB

EE | [EE

End Threshold

Apply Cancel |

Figure 7-8. Trace Reanalysis

Window (W)

The “Window” menu (Figure 7-9) controls the display of the subwindows: trace window, events
table window, parameter window, and fiber chain information. Tile function displays subwindows
in a layout similar to Figure 7-1. Other submenus take the selected window as the current active
window.

Window Hebp

Cascade

v Trace
EventTable
Parameters
Marker Information
Total Fiber Information

Figure 7-9. Window Menu

Help (H)
The “Help” menu (Figure 7-10) displays the version of the software.

| Heb.

About OTDR Trace View...
Figure 7-10. Help Menu
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Information Subwindows

Trace Display Window

Click “Open...” under the “File”” menu to open a trace file, and a trace curve will display in the
trace display window (Figure 7-11). The x-axis displays the distance (km); the y-axis represents
the backscatter power (dB). There are two markers, A and B; click either one to activate it. To
move the marker, click and drag with the mouse pointer; the position information will change
accordingly. By moving the marker, the horizontal distance and vertical power can be read
manually. Zooming in and out of the trace features depends on the activation of a marker. In
Figure 7-11 below, the sloped line represents backscatter from the optical fiber. The peaks are
reflective events in the fiber chain. The end of the fiber is shown by the sudden drop in optical
power, which is followed by noise. The symbols at the bottom of the window indicate the type of
event.

Trace 4.1 km/Div 6,0 dBf Div

A 000000 bl i 4 B 1636073 km

Figure 7-11. Trace Display

Events List Window

Trace data collected by the 930XC will be processed automatically, and analysis results will be
displayed in the events list (Figure 7-12).

Event Table e =10]x]
Dist.Endlam] :

1 F S@rt  0.00000 -46.300 -—— - X - 25.29358 -—

2 ™~ Ro.. 12.33.. -— 0005 -0.555 4,827 12,2239 13.06969 4.827

3 4 Emd  2539.. -23.907 - 09.191 .00 12.06963 - 4,832

Figure 7-12. Events List

The events list contains the following items:
e No.: Sequence of events in optical fiber chain.
e Type: Beginning, end, reflection, and non-reflection event.
* Distance: Distance from OTDR to event point.
* Reflection Value: Value of reflection event.
* Insertion Loss: Vertical decline of dB.

e Attenuation Coefficient: Value of attenuation per kilometer between current event point and
previous event point in optical fiber chain.

e Cumulative Loss: dB value of loss from 0 km to current event point.

e Dist. Prev. (km): Distance from the previous event.
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¢ Dist. End. (km): Distance from the end event.
* Loss Prev. (dB): Loss from 0 km to current event point.
e Comment: Notify other details of the event.

Parameter Window

The parameter window (Figure 7-13) displays the default parameters of the currently displayed
trace. Measurement parameters include: range, pulse width, average time, and wavelength.
Analysis parameters include: IOR, scattering coefficient, end threshold, non-reflection threshold,
reflection threshold, and samp. dist. For definitions of these parameters, refer to “Parameter
Configuration” in Section 3 of this manual.

=10 x|
ange 40,0 km
ulzeWidth 300 n=
avelength 1550 nm
IOR 1. 46660
Scatter Coef. -52.1 df
iverage Time : 00:00:158
End Threshold : 3.000 dE
WRefl. Threshold 0.200 dB
Fefl. Threshold =52.000 dB
Samp. Dist: 2.56 m

Figure 7-13. Parameters

Fiber Section Information Window

This window (Figure 7-14) displays the distance between marker A and B, attenuation coefficient,
and loss information. The two point loss is the difference of vertical power between marker A and
B. Two point attenuation is the two point loss of marker A and B divided by the horizontal distance
between marker A and B.

=101 x|
-F: 970.63 m

2pt. Loss: 0.181 dB

2pt. Attn. : 0. 186 dB/km

LSA Attn. : 0.202 dB/km

Ins.Loss at A: -.——— db

Fefl, at 4: -47.601 dB

2pt. OFL: 43. 212 db

Cum. Loss to & 0.732 dB

Figure 7-14. Fiber Section Information
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Fiber Chain Information Window

The contents displayed in this window (Figure 7-15) are date of measurement, length of fiber
chain, loss of fiber, attenuation, ORL, and event number of fiber.

= Total Fiber Information | =10] x|
Eeasure Date: 05/08/2012 13:44:27

Total Length: 6.43391 km

Total Loss: 2,717 dB
Total Attn. : 0.422 dB/km
Total ORL: 27,833 dB
[Evert Number: 3

Figure 7-15. Fiber Chain Information

Software Functions

Upload Trace Data
Option 1:

Power off the 930XC, and then connect the 930XC to a PC via USB cable. Turn the 930XC on
and wait for PC to recognize 930XC as an USB memory device. Find “trace” folder to copy saved
files to PC.

Option 2:

Power off the 930X C, and then connect the 930X C to a PC via serial cable. Turn the 930XC on
and run the 930XC OTDR Trace Viewer software. Under the “File” menu, select “Upload trace
file...”, and the “Communications Settings” dialog box appears. Choose a communication port
(RS-232) and click “OK”. Choose the saved position of traces, and then start uploading data.

x|

Port |rs232 ;|| O |

RS232 E"III! -I
Cancel |
BEpudiate lli‘:. -I

Figure 7-16. Upload Trace Data
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Browse Traces

Tool Bar

SaH DI Ol azg|Tana|~Me[t|2]3]4

Move the mouse pointer over the tool bar and an explanation of the buttons will pop up.
Their functions are as follows:

Open file

Close file

Save file

Printing preview

Printing

Edit optical fiber information
Zoom out trace

Display whole trace

Zoom in trace horizontally

Zoom out trace horizontally

S LN EIEEE DD B

+ Zoom in trace vertically
I Zoom out trace vertically

™1 Analyze insertion loss (the five-point measurement to test the insertion loss)
= Analyze reflectance
H Lock marker A and B

Display version

’T| 2= 4 Trace number (in multi-trace display mode)
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Open Trace File

Select “Open trace file...” under the “File” menu, and choose the trace file to be reviewed

(Figure 7-17). Select “Tile” under the “Window” menu to automatically rearrange the subwindows
as shown in the figure below.

File Edit View OTDR Window Help
FadD&s e oalld
®

Lk

Greenlee 930XC OTOR Trace Viewer - [chusers\jis\desktoph252%96.50r]
= =l|H T

Trace 4.1 kmyDiv 6.0 dB/Div

ol =& @

Parameters

T 1635300 km | EAEAEIT y—

i 1 FulseWidth
Wavslangth
10K

esrar

af.
crage Tine
End Threshold
BRet 1, Thenshold
tetl. Threshold
[Sanp, Dist

400 bm
00 nr
1550 v
L. 4880
£2.1 &
00, 00, 30
Lo &
0,300 &
52000 dif

.56 m

®  Marker Information

=

£.54052 bm

0188

R 2529358 Total Length: 25,
4750 25.29358 ’ 4750

fept, Loss LT @
g, At 0151 Een
54 deen. 0150 e
Ins.loss at & -Z44% a8
Botl, av kBl %0 &
{2pt. ORL N B
b cunloss to A ATET &
® Event Table = (G % | | W Total Fiber Information  [aclieci]
Nov | Type | Locatin | ReffdB] | Inshosside | AtnldBiion] | Cumdossl.. | DistPrevikm] | Di | Lose PrevdB] | Comment Measuze Date: O3(Z6/2013 13 06 42
1 F Start 000000 -47.487 pe o
2 4 End 25293 37429

29350 kn

4740 4B
Total Aztn. 0,100 diin
Tatal ORL 32,514 4R
Event Mumber: 2

Figure 7-17. Open Trace File

Zoom in and out of Trace
Trace curves are displayed in the trace window (Figure 7-17).

To view in more detail, drag the marker to the trace detail to be reviewed and then:
e Zoom in trace horizontally: Click 44 on the tool bar.

e Zoom out trace horizontally: Click » « on the tool bar.

Zoom in trace vertically: Click 1I% on the tool bar.
Zoom out trace vertically: Click % on the tool bar.
Whole trace: Click A on the tool bar.

Or zoom in by drawing square with mouse on selected trace area from upper left to lower right
direction, and zoom out by drawing square from any other direction.

Note:

e Zoom in or out is centered on the trace features of the activated marker.

* The software supports floating menu operation. Right click the mouse on the window in order
to display the operations that can be performed, including zoom in and out of trace.

Review Trace Information

Trace information includes: trace measurement parameters, analysis parameters, fiber section
information, fiber chain information, and the events list.
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Trace Parameter

Measurement parameters and analysis parameters display in the parameter window (Figure 7-18).

1o

ange 40,0 km

ulzeWidth : 300 n=
avelength : 1550 nm
IOR : 1. 46660
Scatter Coef. : -52.1 dB
iverage Time : 00:00:158
End Threshold : 3.000 dE

WRefl. Threshold 0.200 dB
Fefl. Threshold =52.000 4B
Samp. Dist: 2.56 m

Figure 7-18. Parameters

Fiber Section Information

The distance between marker A and B should be considered as one section of optical fiber
(Figure 7-19).

~ Marker Information =18] x|
B 970.63 m

2pt. Loss: 0.181 dB

2pt. Attn. : 0. 186 dE/km

LS4 Attn.: 0.202 dB/km

Ins.Lozs at 4: -.—— db

Fefl., at 4: =q47.601 dB

Zpt. OFL: 43.212 dB

Cum. Loss to A 0.732 dB

Figure 7-19. Fiber Section Information

Fiber Chain Information

The distance from beginning to end should be considered as a fiber chain (Figure 7-20).

= Total Fiber Information | - |o) x|
Esasurs Date: 06/08/2012 13:44:27

Total Length: 6.43351 kn

Total Logs: 2.717 dB
Total Attn.: 0.422 dB/km
Total OFL: 27,833 dB

[Evert Number: 3

Figure 7-20. Fiber Chain Information

930XC-20C * 930XC-20M ¢ 930XC-30F * 930XC-30P Instruction Manual 57



Section 7

58

Review Events List

The trace curve decreases at a fixed slope. Any sudden peak or drop should be considered an
event. The 930XC acquires measured data automatically and creates the events list (Figure 7-21).

=10]x]

Event Table

1 F SGt  0.00000 46300 -— - . -
2~ No.. 1232, — 0.095 0,555 4,827 12.22389 1306969 4.827
3 4 End 2520, 23807 - 0.191 0000 1306969 — 4.832

Figure 7-21. Review Events List

For details relating to the events list, refer to “Events List Window” in this section.

Save Trace

Opened trace files can be saved in the same manner as other files. Click “save trace file” under the
“File” menu to save a trace with an existing file name. Click “save as trace file” under the “File”
menu to save a trace with a new file name.

ASCII Format Output

Trace Viewer software provides a software interface so that data can be exported in ASCII format
and then opened and viewed by a third-party application like MS Excel.

Select “ASCII format output” under the “File” menu (Figure 7-22). Select the information and
format, and then press Enter to choose the path and file name.

x|
-~ Separator

[¥ Trace Info & Space
[# Neas. Inf.

ERS 8 " Comma
[+ Event Table
¥ Trace Data C TAB

oK | Cancel |

Figure 7-22. ASCII Format

Edit Optical Fiber Information

Select “Edit information of optical fiber” under the “Edit” menu, or click i to start editing
optical fiber information (Figure 7-23). Information of optical fiber is a description of
measurement trace displayed in the trace window. Users input relevant information for efficient
management of measurement files. Upon completion of editing, press Enter to confirm.

[rrace informabon x|

Labels Coanents

Cable ID [

Fiber ID |

Fiber Type IConvtntic.nal Singlemade Fiber EI

Orig. Location I
Tern.Location |
Operator |
Device |

e ] Cancel |
Figure 7-23. Edit Optical Fiber Information
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Revise Events List

Because field measurement situations are constantly changing, the 930XC analysis software
cannot guarantee that every analysis is correct. The software provides an interface for users to
revise the events list: add event, revise event, delete event, and delete events list.

Add Event

If an event on the measurement trace is not listed in the events list (due to inaccuracies caused

by poor SNR or inadequate parameter configuration), use the “add event” function to manually
add this event into the events list. Click the events list window, and select “Add event” under the
“Editing” menu (Figure 7-24). Choose the type of event from the pull-down menu, enter the event
features, and then press Enter to add the event to the events list.

x|

Event Type |N0nREf1. 'l

Location IW kn
Reflectance I—l-;ﬂu— dB
Attenuation [0.209901 gb/km
Ins. Loss Ir aB
Cum. Loss [0 dB

_omen|

Figure 7-24. Add Event

Revise Event

Use the “revise event” function to manually revise features of an event (due to inaccuracies caused
by poor SNR or inadequate parameter configuration). Select the event to be revised in the events
list window, and select “Revise event” (Figure 7-25). After modifying the event feature(s), press
Enter to confirm the changes. The software will automatically refresh the event sequence.

Events can also be revised by clicking on the event to access a pop-up menu.

ErrE—
Event Type lm
Location IW km
Reflectance l'__ dB
sttenuation [0.21  db/im
Ins. Loss lr dF
Cum, Loss F_. dB

0% ! Cancel

Figure 7-25. Revise Event

Delete Event

Use the “delete event” function to manually delete a trace from the events list when it appears in
error (due to inaccuracies caused by poor SNR or inadequate parameter configuration). Highlight
the event to be deleted, and then select “Delete event” under the “Editing” menu.

Events can also be deleted by clicking on the event to access a pop-up menu.
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Printing
Printing Options

Select “Printing options...” under the “File” menu (Figure 7-26), to select the contents to be

printed.
x|
¥ Trace Infornatic = Hormal
v Trace  Vigable Trace
¥ Show Grid
[¥ Show Narker € Wultl Trace
[+ Fiber Info
[¥ Event Table
[ Narker Info
" Logo | _I
et |
Figure 7-26. Printing Options
Printing Setup

Select “Printing setup” under the “File” menu (Figure 7-27) to select the printer, paper size, and
printing orientation.

x

~ Prnter

Status:  Ready

Type: Solid POF Tools
Where:  Solid POF Post:
Comment:

~ Paper Orientation
Sze: A4

n
-
i

Source:  [Man Paper Tray

Network..._| [ oK | Cancel

Figure 7-27. Printing Setup
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Printing Preview

To preview the page before printing, select “Printing preview” under the “File” menu or click E

on the tool bar (Figure 7-28).

3= ‘Greenlee 930XC OTDR Trace Viewer - [c\users\jia\desktop\25296.sor] “
CEFInE | Hexct Paze | [Prev Paze| Two Paze |[ Zoom In J[Zoom Out | Close |
-~
OTDR Report
Ak - 25296 sor TestDate "03-252013 130642 Davke
Cabke ID: OnigLosation -
FveriD Tem.Locatbn :
opemmr: Fber Type - Conventional Shgemads Flaer
Range:- 400km PuleWEm : 300ns Wavekngh - 1550 nm
IOR - 1.46680 ‘Scamer Coetf. - £2.100B Average Tme - 000030
End Thesholl - 30008 NRefiTheshol - 02048 Refl Theshol - £200 4B
Taoce & 088 km/ON 6000 a8/DY
CREEELARY: 2520355 kn | i H i A
Makes AB Magera
AB. 8.94082 km Pogition: 25294km
2pt Loss: 1707 @B ns Loss at#2: 2443408
2pt Aterwatbn: 0.191 gBkm Refectance at#Z 5492008
LSA-ARenuation: 0.190 aB&km Cum. Lossto AC 4757 dB
2pt ORL: 338648 o e
Total Rber
TotalLeng®h 25 29358 km TotzlLoss4.749 dB Total Attn 20.188 dEVkm ToRIORL:32514 dB
Event Tabie
M. Tipe _ocmoner] Retjog rslomfo] AmjoSkm] CumicmhS] OmPreyfkn] OmEndor] LossPreviS] Comrent
1 San 0.00000 ATAGTT = e e 2.000 25294 e o
F ena 252933 aT4B = 0133 4750 5254 0.000 475008 Sy
W
Y

Figure 7-28. Printing Preview

Printing
Select “Printing” under the “File” menu, or click E on the tool bar (Figure 7-29).

Type:  Solid POF Taels
Where:  Solid PDF Port:

Comment: [~ Print to file
r Print range Copies
& M Number of copies: |1 =
€ Pages Irorrrl'l tor |1 5 : X
€ st L 22 33
Salecton |
OK Cancal

Figure 7-29. Printing
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Batch Edit

The 930X C Trace Viewer software has a batch-edit function that allows users to edit the trace
information of several trace files in the same folder at one time. Select “Batch Edit” under the

“File” menu (Figure 7-30).

62

CEET———— ]
Falder Files in Folder Flles to Edit
Greenlee 10 ;E [i=no
| EDDScan 3.3 [eag
i lg Downloads 1
b &xaaple
L Faverltes
Adchie
i Business Dn
I lirkedin | e
! T =
add M1 3] ey o] e | e
Salect to Change Starting Flber Fuaber
™ Fiber 1D [ r i
I” Cable ID [ Clear 11 Text |
I Fiber Typs =]
™ orig. Lecation |
I” Ters.Lecation
™ Operator cancel

Figure 7-30. Batch Edit

Batch Print

The 930XC Trace Viewer software has a batch-print function that allows users to print several
trace files in the same folder at one time. Select “Batch Print” under the “File” menu (Figure 7-31).

Ej

Folder Files §n Fol Flles 1o Edit

& 0 7 Tods =& T -
# b 910 L
. Gresnlee 10
HPEcan_ 5 3
| Trace
¥ b Downloads
| =xample
= iy Favarites |
Adabie
Business
linkedin

Ill Links _,.‘lJ

add 411 5 | ine | agaxn |

Figure 7-31. Batch Print
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Batch Print Preview

To preview before batch printing, select “batch print preview” under the “File” menu
(Figure 7-32).

Hext Pagel Frev Fage | Two Fagze I Zoom In I Zoom Out I Cloze I

OTDR Report

IER SEfur Tl SEES  SEE P S - Smihar  Teslas HEES RS
e ugLecatn : e D Cviglacuan ©

T L

Rk T Convaned Saata, Ol
Trach <o b G R

T

Figure 7-32. Batch Print Preview
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Exit Software

Press “Exit” under the “File” menu (Figure 7-33) to exit the Trace Viewer software.

GREENLEE.

A Textron Company

File Edt View OTDR Window Help
Upload Trace File...

Open... Ctrl+0

Multi-traces L

Save Ctri+5
Save As...

ASCI Export...

Print Option...

Print Praview

Print Setup...

Print... Ctrl+P

Batch Print Preview
Batch Print
Batch Edit

1 c:\userg!:.desktnp\zszgﬁ

2 c\users\...\trace\demo (1)
3 C:\Users\...\Trace\Demo (2}
4 c\users\...\trace\demo (3)

Figure 7-33. Exit Software
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